# Contents

1. Aloha ................................................................................................................. 1
2. CSMA .................................................................................................................. 6
3. CSMA/CD ........................................................................................................... 11
4. Token Bus ........................................................................................................... 16
5. Token Ring ....................................................................................................... 21
6. Stop and Wait .................................................................................................... 25
7. Stop and Wait with BER ................................................................................... 28
8. Sliding Window Go Back N ............................................................................... 30
9. Sliding Window Go Back N with BER ............................................................... 33
10. Packet Transmission ......................................................................................... 35
11. File transfer ...................................................................................................... 38
12. Appendix 1 Graph plot procedure .................................................................. 41
13. Appendix 2 Configuration menu details .......................................................... 48
14. Appendix 3 Developing Lan-T application ...................................................... 50
Experiment 1 – ALOHA

Aim:
Implement the ALOHA protocol for packet communication between a number of nodes connected to a common bus

Procedure:
1. Click on the MAC Experiment icon twice from the desktop on both PC’s.
2. Click the Configuration button in the window in both the PC’s.

<table>
<thead>
<tr>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Configuration View" /></td>
<td><img src="image2.png" alt="Configuration View" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Configuration View</th>
<th>Configuration View</th>
</tr>
</thead>
</table>

Setting the Configuration menu:

<table>
<thead>
<tr>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node id</strong></td>
<td>0 on config menu 1 and 1 on config menu 2</td>
</tr>
<tr>
<td><strong>Protocol</strong></td>
<td>ALOHA</td>
</tr>
<tr>
<td><strong>Baud Rate</strong></td>
<td>8Kbps (At both the config menu and NEU)</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>100s</td>
</tr>
<tr>
<td><strong>Packet Length</strong></td>
<td>100 bytes</td>
</tr>
<tr>
<td><strong>Bit Delay</strong></td>
<td>0(at NEU)</td>
</tr>
<tr>
<td><strong>Direction</strong></td>
<td>Sender</td>
</tr>
</tbody>
</table>

Note: All the nodes have to be configured as ‘Senders’. Set the topology as ‘Bus’. 
**Aloha**

\[
G = \frac{N \times P}{C \times t_a}
\]

\(G\) is the generated load in the network.

\(N\) is the number of nodes participating in the network. For example, let us say that 4 nodes (using 2 computers)

\(P\) is the packet length expressed in bits; say 100 bytes (800 bits).

\(C\) is the data rate normally set as 8kbs, which is selected in the NEU.

\(t_a\) is the inter packet delay expressed in seconds; the time interval between two consecutive packets generated.

So, let’s assume \(t_a = 40\) milliseconds and substitute the above mentioned parameters in the Equation A which leads to \(G = 10\). Like wise assume various values for \(t_a\) to generate offer loads in the range of 0.1 to 10. Substitute the value of \(t_a\) in the configuration menu.

3. Click **OK** button and Download the driver to the NIU using the BOOT button command. Booting from any one of the applications is enough.

4. Run the experiment by clicking button or by choosing **RUN → Start** from each application.
5. View the statistics window for results. To view the statistics window click on button. Only Tx packets and collision count are taken into account for MAC calculation.

**PC 1**

![Node ALOHA - Sender Statistics](image1)

**PC 2**

![Node ALOHA - Sender Statistics](image2)

6. Note down the readings once the experiment is completed.
7. Repeat the above steps for various values of $t_a$.
8. Calculate the Practical offered load from the below given formula and plot the graph between the practical Offered load and Throughput.

**Note:** You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template.
9. Repeat the experiment for various values of Packet length, Node, Data rate.

**Calculation of Practical Throughput (X) from the obtained readings:**
Successively transmitted packet by a node = Tx Packets - Collision Count

\[
X = \frac{\text{(Sum of Successfully Tx packet in all the nodes * Packet Length * 8)}}{\text{(Duration of Experiment * Data rate)}}
\]

**Calculation of Theoretical Throughput:**

\[
X = G e^{-2G}
\]

**Calculation of Practical Offered load:**

\[
G = \frac{\text{(Sum of Transmitted packets in all the nodes * Packet Length * 8)}}{\text{(Duration of Experiment * Data rate)}}
\]
**Model tabulation:**

<table>
<thead>
<tr>
<th>IPD</th>
<th>Tx1</th>
<th>Tx 2</th>
<th>Tx 3</th>
<th>Tx 4</th>
<th>G – Practical Offered Load</th>
<th>X – Practical Throughput</th>
<th>Theoretical Throughput</th>
</tr>
</thead>
<tbody>
<tr>
<td>4000</td>
<td>23</td>
<td>19</td>
<td>25</td>
<td>16</td>
<td>0.101</td>
<td>0.083</td>
<td>0.08</td>
</tr>
<tr>
<td>2000</td>
<td>36</td>
<td>35</td>
<td>38</td>
<td>33</td>
<td>0.2</td>
<td>0.142</td>
<td>0.13</td>
</tr>
<tr>
<td>800</td>
<td>54</td>
<td>48</td>
<td>43</td>
<td>60</td>
<td>0.444</td>
<td>0.205</td>
<td>0.18</td>
</tr>
<tr>
<td>400</td>
<td>52</td>
<td>41</td>
<td>39</td>
<td>45</td>
<td>0.766</td>
<td>0.177</td>
<td>0.14</td>
</tr>
<tr>
<td>200</td>
<td>18</td>
<td>26</td>
<td>11</td>
<td>19</td>
<td>1.293</td>
<td>0.074</td>
<td>0.04</td>
</tr>
<tr>
<td>100</td>
<td>10</td>
<td>1</td>
<td>4</td>
<td>10</td>
<td>1.82</td>
<td>0.025</td>
<td>0.00</td>
</tr>
<tr>
<td>40</td>
<td>4</td>
<td>0</td>
<td>0</td>
<td>6</td>
<td>2.484</td>
<td>0.01</td>
<td>0.00</td>
</tr>
</tbody>
</table>

**Model Graph:**

[Offered Load Vs Throughput diagram]

Throughput (X) vs Offered Load (G)
Experiment 2 – CSMA

Aim:
Implement the CSMA protocol for packet communication between a number of nodes connected to a common bus

Procedure:

1. Click on the **MAC** Experiment icon twice from the desktop on both PC’s.
2. Click the Configuration button in the window in both the PC’s.

<table>
<thead>
<tr>
<th>Configuration menu:</th>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node id</strong></td>
<td>0 on config menu 1 and 1 on config menu 2</td>
<td>0 on config menu 1 and 1 on config menu 2</td>
</tr>
<tr>
<td><strong>Protocol</strong></td>
<td>CSMA</td>
<td>CSMA</td>
</tr>
<tr>
<td><strong>Baud Rate</strong></td>
<td>8Kbps (At both the config menu and NEU)</td>
<td>8Kbps (At both the config menu and NEU)</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td>100s</td>
<td>100s</td>
</tr>
<tr>
<td><strong>Packet Length</strong></td>
<td>100 bytes</td>
<td>100 bytes</td>
</tr>
<tr>
<td><strong>Bit Delay</strong></td>
<td>10 (at NEU)</td>
<td>10 (at NEU)</td>
</tr>
<tr>
<td><strong>Direction</strong></td>
<td>Sender</td>
<td>Sender</td>
</tr>
</tbody>
</table>

Note: All the nodes have to be configured as ‘Senders’. Set the topology as ‘Bus’.
$G = \frac{N \times P}{C \times t_a}$

$G$ is the generated load in the network.
$N$ is the number of nodes participating in the network. For example, let us say that 4 nodes (using 2 computers)
$P$ is the packet length expressed in bits; say 100 bytes (800 bits).
$C$ is the data rate normally set as 8kbs, which is selected in the NEU.
$t_a$ is the inter packet delay expressed in seconds; the time interval between two consecutive packets generated.

So, lets assume $t_a = 40$ milliseconds and substitute the above mentioned parameters in the Equation A which leads to $G = 10$. Like wise assume various values of $t_a$ to generate offer loads in the range of 0.1 to 10. Substitute the $t_a$ in the configuration menu.

3. Click **OK** button and Download the driver to the NIU using the BOOT button command. Booting from any one of the applications is enough.

4. Run the experiment by clicking button or by choosing RUN → Start from each application.

5. View the statistics window for results. To view the statistics window click on button. Only Tx packets and collision count are taken into account for MAC calculation.
6. Note down the readings once the experiment is completed.
7. Repeat the above steps for various values of $t_a$.
8. Calculate the Practical offered load from the below given formula and plot the graph between the practical Offered load and Throughput.

**Note:** You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template.
9. Repeat the experiments for various values of Packet length, Node, Data rate and Bit delay.
**Calculation of Practical Throughput (X) from the obtained readings:**

Successfully transmitted packet by a node = Tx Packets - Collision Count

\[
X = \frac{(\text{Sum of Successfully Tx packet in all the nodes} \times \text{Packet Length} \times 8)}{(\text{Duration of Experiment} \times \text{Data rate})}
\]

**Calculation of Theoretical Throughput:**

\[
X = \frac{G(1+G+aG(1+G+aG/2)e^{-G(1+2a)})}{G(1+2a)-(1-e^{-aG})(1+aG)e^{-G(1+a)}}
\]

\(a = (\text{end to end bit delay in bits}) / (\text{Packet length in bits}) = (\text{bit delay}\times N) / (P)\)

**Calculation of Practical Offered load:**

\[
G = \frac{(\text{Sum of Transmitted packets in all the nodes} \times \text{Packet Length} \times 8)}{(\text{Duration of Experiment} \times \text{Data rate})}
\]
Model tabulation:

For bit delay = 1

<table>
<thead>
<tr>
<th>IPD</th>
<th>Tx1</th>
<th>Tx 2</th>
<th>Tx 3</th>
<th>Tx 4</th>
<th>G – Practical Offered Load</th>
<th>X – Practical Throughput</th>
<th>Theoretical Throughput</th>
</tr>
</thead>
<tbody>
<tr>
<td>4000</td>
<td>29</td>
<td>28</td>
<td>29</td>
<td>28</td>
<td>0.116</td>
<td>0.114</td>
<td>0.11</td>
</tr>
<tr>
<td>2000</td>
<td>49</td>
<td>50</td>
<td>49</td>
<td>49</td>
<td>0.197</td>
<td>0.197</td>
<td>0.19</td>
</tr>
<tr>
<td>800</td>
<td>107</td>
<td>93</td>
<td>99</td>
<td>101</td>
<td>0.436</td>
<td>0.400</td>
<td>0.37</td>
</tr>
<tr>
<td>400</td>
<td>151</td>
<td>124</td>
<td>134</td>
<td>144</td>
<td>0.725</td>
<td>0.553</td>
<td>0.49</td>
</tr>
<tr>
<td>200</td>
<td>166</td>
<td>156</td>
<td>155</td>
<td>165</td>
<td>1.076</td>
<td>0.642</td>
<td>0.53</td>
</tr>
<tr>
<td>100</td>
<td>137</td>
<td>103</td>
<td>126</td>
<td>116</td>
<td>1.388</td>
<td>0.482</td>
<td>0.52</td>
</tr>
<tr>
<td>40</td>
<td>12</td>
<td>12</td>
<td>7</td>
<td>37</td>
<td>1.824</td>
<td>0.068</td>
<td>0.48</td>
</tr>
</tbody>
</table>

Model Graph:

![Offered Load Vs Throughput Graph]

- X - Throughput
- X - Theoretical
Experiment 3 – CSMA/CD

Aim:
Implement the CSMA/CD protocol for packet communication between a number of nodes connected to a common bus

Procedure:
1. Click on the MAC Experiment icon twice from the desktop on both PC’s.
2. Click the Configuration button in the window in both the PC’s.

Configuration menu:

<table>
<thead>
<tr>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node id</strong></td>
<td><strong>Node id</strong></td>
</tr>
<tr>
<td>0 on config menu 1 and 1 on config menu 2</td>
<td>0 on config menu 1 and 1 on config menu 2</td>
</tr>
<tr>
<td><strong>Protocol</strong></td>
<td><strong>Protocol</strong></td>
</tr>
<tr>
<td>CSMA/CD</td>
<td>CSMA/CD</td>
</tr>
<tr>
<td><strong>Baud Rate</strong></td>
<td><strong>Baud Rate</strong></td>
</tr>
<tr>
<td>8Kbps (At both the config menu and NEU)</td>
<td>8Kbps (At both the config menu and NEU)</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td><strong>Duration</strong></td>
</tr>
<tr>
<td>100s</td>
<td>100s</td>
</tr>
<tr>
<td><strong>Packet</strong></td>
<td><strong>Packet</strong></td>
</tr>
<tr>
<td>1000 bytes</td>
<td>1000 bytes</td>
</tr>
<tr>
<td><strong>Bit Delay</strong></td>
<td><strong>Bit Delay</strong></td>
</tr>
<tr>
<td>0(at NEU)</td>
<td>0(at NEU)</td>
</tr>
<tr>
<td><strong>Direction</strong></td>
<td><strong>Direction</strong></td>
</tr>
<tr>
<td>Sender</td>
<td>Sender</td>
</tr>
</tbody>
</table>

Note: All the nodes have to be configured as 'Senders'. Set the topology as 'Bus'.
G is the generated load in the network.
N is the number of nodes participating in the network. For example, let us say that 4 nodes (using 2 computers)
P is the packet length expressed in bits; say 100 bytes (800 bits).
C is the data rate normally set as 8kbs, which is selected in the NEU.
tₐ is the inter packet delay expressed in seconds; the time interval between two consecutive packets generated.

So, lets assume tₐ = 40 milliseconds and substitute the above mentioned parameters in the Equation A which leads to G = 10. Like wise assume various values of tₐ to generate offer loads in the range of 0.1 to 10. Substitute the value of tₐ in the configuration menu.

3. Click OK button and Download the driver to the NIU using the BOOT button command. Booting from any one of the applications is enough.

4. Run the experiment by clicking button or by choosing RUN → Start from each application.

5. View the statistics window for results. To view the statistics window click on button. Only Tx packets and successfully transmitted packets are taken into account for CSMA/CD calculation.
6. Note down the readings once the experiment is completed.

7. Repeat the above steps for various values of $t_a$.

8. Calculate the Practical offered load from the below given formula and plot the graph between the practical Offered load and Throughput.

   **Note:** You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template.

9. Repeat the experiment for various values of Packet length, Node, Data rate.
**Calculation of Practical Throughput (X) from the obtained readings:**

\[
X = \frac{\text{(Sum of Successfully Tx packet in all the nodes} \times \text{Packet Length} \times 8)}{\text{(Duration of Experiment} \times \text{Data rate})}
\]

**Calculation of Practical Offered load:**

\[
G = \frac{\text{(Sum of Offered load count in all the nodes} \times \text{Packet Length} \times 8)}{\text{(Duration of Experiment} \times \text{Data rate})}
\]

* offered load count and successfully transmitted packet count is displayed in the main window of CSMA/CD experiment.
Model tabulation:

<table>
<thead>
<tr>
<th>IPD</th>
<th>Tx1</th>
<th>Tx 2</th>
<th>Tx 3</th>
<th>Tx 4</th>
<th>G – Practical Offered Load</th>
<th>X – Practical Throughput</th>
</tr>
</thead>
<tbody>
<tr>
<td>4000</td>
<td>27</td>
<td>25</td>
<td>24</td>
<td>24</td>
<td>0.101</td>
<td>0.1</td>
</tr>
<tr>
<td>2000</td>
<td>49</td>
<td>49</td>
<td>49</td>
<td>49</td>
<td>0.208</td>
<td>0.196</td>
</tr>
<tr>
<td>800</td>
<td>118</td>
<td>116</td>
<td>119</td>
<td>116</td>
<td>0.5</td>
<td>0.469</td>
</tr>
<tr>
<td>400</td>
<td>187</td>
<td>189</td>
<td>191</td>
<td>191</td>
<td>0.976</td>
<td>0.758</td>
</tr>
<tr>
<td>200</td>
<td>117</td>
<td>133</td>
<td>290</td>
<td>300</td>
<td>1.904</td>
<td>0.84</td>
</tr>
<tr>
<td>100</td>
<td>472</td>
<td>463</td>
<td>13</td>
<td>18</td>
<td>3.555</td>
<td>0.966</td>
</tr>
<tr>
<td>40</td>
<td>466</td>
<td>458</td>
<td>20</td>
<td>28</td>
<td>7.687</td>
<td>0.972</td>
</tr>
</tbody>
</table>

Model Graph:

![Offered Load Vs Throughput Graph](image)
**Experiment 4 - TOKEN BUS**

**Aim:**
To implement the token passing access in BUS-LAN

**Procedure:**
1. Click on the Token Bus icon twice from the desktop.
2. Click the Configuration button in the window in both the PC’s.

### PC 1 – Sender

![Configuration Menu](image1.png)

### PC 2 – Sender

![Configuration Menu](image2.png)

**Setting the configuration menu:**

<table>
<thead>
<tr>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Node id</strong></td>
<td><strong>Node id</strong></td>
</tr>
<tr>
<td>0 on config menu 1 and 1 on config menu 2</td>
<td>0 on config menu 1 and 1 on config menu 2</td>
</tr>
<tr>
<td><strong>Protocol</strong></td>
<td><strong>Protocol</strong></td>
</tr>
<tr>
<td>ALOHA</td>
<td>ALOHA</td>
</tr>
<tr>
<td><strong>Baud Rate</strong></td>
<td><strong>Baud Rate</strong></td>
</tr>
<tr>
<td>8Kbps (At both the config menu and NEU)</td>
<td>8Kbps (At both the config menu and NEU)</td>
</tr>
<tr>
<td><strong>Duration</strong></td>
<td><strong>Duration</strong></td>
</tr>
<tr>
<td>100s</td>
<td>100s</td>
</tr>
<tr>
<td><strong>Packet Length</strong></td>
<td><strong>Packet Length</strong></td>
</tr>
<tr>
<td>100 bytes</td>
<td>100 bytes</td>
</tr>
<tr>
<td><strong>My Address</strong></td>
<td><strong>My Address</strong></td>
</tr>
<tr>
<td>0 on config menu 1 and 1 on menu 2</td>
<td>2 on config menu 1 and 3 on menu 2</td>
</tr>
<tr>
<td><strong>Bit Delay</strong></td>
<td><strong>Bit Delay</strong></td>
</tr>
<tr>
<td>0(at NEU)</td>
<td>0(at NEU)</td>
</tr>
<tr>
<td><strong>Direction</strong></td>
<td><strong>Direction</strong></td>
</tr>
<tr>
<td>Sender</td>
<td>Sender</td>
</tr>
</tbody>
</table>

**Notes**

1: If you connect two PC’s and configured four nodes then set the **My Address** as 0 to 3 in all four nodes, if you connect three PCs and configured six nodes then set the **My Address** as 0 to 5 in all six nodes.

2: Start running the experiment from the lowest priority node (i.e., from My Address 3 in case of four nodes and 5 in the case of six nodes)

3: No of Nodes has to be set as 4 when two PCs are connected and 6 when three PCs are connected.
**Token Bus**

\[
G = \frac{N \times P}{C \times t_a}
\]

- **G** is the generated load in the network.
- **N** is the number of nodes participating in the network. For example, let us say that 4 nodes (using 2 computers)
- **P** is the packet length expressed in bits; say 100 bytes (800 bits).
- **C** is the data rate normally set as 8kbs, which is selected in the NEU.
- **t_a** is the inter packet delay expressed in seconds; the time interval between two consecutive packets generated.

So let's assume \(t_a = 40\) milliseconds and substitute the above mentioned parameters in the Equation A which leads to \(G = 10\). Like wise assume various values of \(t_a\) to generate offer loads in the range of 0.1 to 10. Substitute the value of \(t_a\) in the configuration menu.

3. Click **OK** button and Download the driver to the NIU using the BOOT button command. Booting from any one of the applications is enough.

4. Run the experiment by clicking button or by choosing RUN \(\rightarrow\) Start from each application.
   Run the all the experiments at the same time.

5. Set the Token Holding Time (**THT**) (say 10000 ms).

![PC 1](image1.png) ![PC 2](image2.png)

**Note:** While you do this **THT** window pops up, enter the THT time in all nodes and press the **OK** button first in the node, which has highest value of **My Address**.
6. View the statistics window for results. To view the statistics window click on button.

7. Note down the readings once the experiment is completed. sw

8. Repeat the above steps for various values of $t_a$.

9. Calculate the Practical offered load from the below given formula and plot the graph between the practical Offered load and Throughput.

   **Note:** You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template.

10. Repeat the experiment for various values of Packet length, Node, Data rate.

11. Repeat the above steps, while running the experiment set the **BER to $10^{-2}$** in the NEU or try to stop one of the nodes and observe the behavior and explain the same.

**Calculation of Practical Throughput ($X$) from the obtained readings:**

\[
X = \frac{(\text{Sum of Tx packet in all the nodes} \times \text{Packet Length} \times 8)}{(\text{Duration of Experiment} \times \text{Data rate})}
\]
Calculation of the Offered load:

\[
G = \frac{N \times P}{C \times t_a}
\]

- \(G\) – Offered load
- \(N\) – Number of nodes
- \(P\) – Packet length in bits
- \(C\) – Data rate in bits/sec
- \(t_a\) – Inter packet delay in milliseconds.

Model Tabulation:

<table>
<thead>
<tr>
<th>IPD</th>
<th>Tx 1</th>
<th>Tx 2</th>
<th>Tx 3</th>
<th>Tx 4</th>
<th>G - Offered Load</th>
<th>X –Practical Throughput</th>
<th>Avg Delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>16000</td>
<td>7</td>
<td>7</td>
<td>9</td>
<td>5</td>
<td>0.25</td>
<td>0.28</td>
<td>12205.5</td>
</tr>
<tr>
<td>8000</td>
<td>11</td>
<td>11</td>
<td>11</td>
<td>13</td>
<td>0.5</td>
<td>0.46</td>
<td>7787.75</td>
</tr>
<tr>
<td>4000</td>
<td>18</td>
<td>21</td>
<td>26</td>
<td>19</td>
<td>1</td>
<td>0.84</td>
<td>11265</td>
</tr>
<tr>
<td>2000</td>
<td>24</td>
<td>20</td>
<td>21</td>
<td>24</td>
<td>2</td>
<td>0.89</td>
<td>28604.75</td>
</tr>
<tr>
<td>1000</td>
<td>20</td>
<td>18</td>
<td>30</td>
<td>20</td>
<td>4</td>
<td>0.88</td>
<td>38216</td>
</tr>
</tbody>
</table>

Model Graph
Experiment 5 - Token Ring

Aim:
To implement the token passing access in RING-LAN

Procedure:
1. Click on the Token Bus icon twice from the desktop.
2. Click the Configuration button in the window in both the PC’s.

Setting the configuration menu:

<table>
<thead>
<tr>
<th></th>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node id</td>
<td>0 on config menu 1 and 1 on config menu 2</td>
<td>0 on config menu 1 and 1 on config menu 2</td>
</tr>
<tr>
<td>Protocol</td>
<td>RING</td>
<td>RING</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>8Kbps (At both the config menu and NEU)</td>
<td>8Kbps (At both the config menu and NEU)</td>
</tr>
<tr>
<td>Duration</td>
<td>100s</td>
<td>100s</td>
</tr>
<tr>
<td>Packet Length</td>
<td>1000 bytes</td>
<td>1000 bytes</td>
</tr>
<tr>
<td>Bit Delay</td>
<td>0(at NEU)</td>
<td>0(at NEU)</td>
</tr>
<tr>
<td>Direction</td>
<td>Sender</td>
<td>Sender</td>
</tr>
</tbody>
</table>
\[
G = \frac{N \times P}{C \times t_a}
\]

\(G\) is the generated load in the network.

\(N\) is the number of nodes participating in the network. For example, let us say that 4 nodes (using 2 computers)

\(P\) is the packet length expressed in bits; say 100 bytes (800 bits).

\(C\) is the data rate normally set as 8kbs, which is selected in the NEU.

\(t_a\) is the inter packet delay expressed in seconds; the time interval between two consecutive packets generated.

So, let's assume \(t_a = 40\) milliseconds and substitute the above mentioned parameters in the Equation A which leads to \(G = 10\). Like wise assume various values of \(t_a\) to generate offer loads in the range of 0.1 to 10. Substitute the value of \(t_a\) in the configuration menu.

3. Click **OK** button and Download the driver to the NIU using the BOOT button command. Booting from any one of the applications is enough.

4. Run the experiment by clicking button or by choosing RUN → Start from each application. Run the all the experiments at the same time.

5. Set the Token Holding Time (\(THT\)) (say 10000 ms).

6. View the statistics window for results. To view the statistics window click on button.

7. Note down the readings once the experiment is completed.

8. Repeat the above steps for various values of \(t_a\).
9. Calculate the Practical offered load from the below given formula and plot the graph between the practical Offered load and Throughput.
   **Note:** You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template.
10. Repeat the experiments for various values of Packet length, Node, Data rate.
11. Repeat the above steps, while running the experiment set the BER to $10^{-2}$ in the NEU or try to stop one of the nodes and observe the behavior and explain the same.

**Calculation of Practical Throughput (X) from the obtained readings:**

\[
X = \frac{(\text{Sum of Tx packet in all the nodes} \times \text{Packet Length} \times 8)}{\text{(Duration of Experiment} \times \text{Data rate)}}
\]

**Calculation of the Offered load:**

\[
G = \frac{N \times P}{C \times t_a}
\]

- $G$ – Offered load
- $N$ – Number of nodes
- $P$ – Packet length in bits
- $C$ – Data rate in bits/sec
- $t_a$ – Inter packet delay in millisecs.
Model Tabulation:

<table>
<thead>
<tr>
<th>IPD</th>
<th>Tx Node1</th>
<th>Tx Node2</th>
<th>Tx Node3</th>
<th>Tx Node4</th>
<th>G - Offered Load</th>
<th>X - Throughput</th>
<th>Avg Delay</th>
</tr>
</thead>
<tbody>
<tr>
<td>16000</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>6</td>
<td>0.25</td>
<td>0.24</td>
<td>3779.75</td>
</tr>
<tr>
<td>8000</td>
<td>12</td>
<td>13</td>
<td>14</td>
<td>14</td>
<td>0.5</td>
<td>0.53</td>
<td>3708.25</td>
</tr>
<tr>
<td>4000</td>
<td>19</td>
<td>19</td>
<td>28</td>
<td>28</td>
<td>1</td>
<td>0.94</td>
<td>3658.5</td>
</tr>
<tr>
<td>2000</td>
<td>22</td>
<td>22</td>
<td>30</td>
<td>25</td>
<td>2</td>
<td>0.99</td>
<td>28270.75</td>
</tr>
<tr>
<td>1000</td>
<td>30</td>
<td>27</td>
<td>21</td>
<td>21</td>
<td>4</td>
<td>0.99</td>
<td>37720.25</td>
</tr>
</tbody>
</table>

Model Graph
**Experiment 6 – STOP & WAIT**

**Aim:**

Provide reliable data transfer between two nodes over an unreliable network using the stop-and-wait protocol

**Procedure:**

1. Click on the **Stop & Wait** icon from the desktop on both PCs.
2. Click the Configuration button in the window in both the PCs.

---

**PC 1 SENDER**

![Configuration View](image1)

**PC 2 RECEIVER**

![Configuration View](image2)

**Setting the configuration menu:**

<table>
<thead>
<tr>
<th>Setting</th>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node id</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Protocol</td>
<td>CSMA/CD</td>
<td>CSMA/CD</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>8Kbps (At both the config menu and NEU)</td>
<td>8Kbps (At both the config menu and NEU)</td>
</tr>
<tr>
<td>Duration</td>
<td>100s</td>
<td>100s</td>
</tr>
<tr>
<td>Packet Length</td>
<td>1000 bytes</td>
<td>1000 bytes</td>
</tr>
<tr>
<td>Bit Delay</td>
<td>0(at NEU)</td>
<td>0(at NEU)</td>
</tr>
<tr>
<td>Direction</td>
<td>Sender</td>
<td>Receiver</td>
</tr>
</tbody>
</table>

Benchmark Electronic Systems
3. Set the **Inter Packet Delay** to 400msecs

4. Click **OK** button and Download the driver to the NIU using the BOOT button command. Booting from any one of the applications is enough.

5. Run the experiment by clicking button or by choosing RUN → Start from each application.

6. Set the Timeout Value to **1500 ms**

7. Note down the no of successfully Transmitted Packets.

8. Repeat the above steps for various **timeout** values and plot the graph between timeout Value & Throughput. Find the optimum timeout value from the plot.

   **Note:** You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template.

9. Explain why the throughput is less compared to CSMACD protocol.

### Calculation of Practical Throughput:

\[
X = \frac{(\text{Sum of Successfully Tx packets} \times \text{Packet Length} \times 8)}{(\text{Duration of Experiment} \times \text{Data rate})}
\]
Model Tabulation:

<table>
<thead>
<tr>
<th>Time out value in ms</th>
<th>Successfully Tx packets</th>
<th>Practical Throughput</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>1</td>
<td>0.01</td>
</tr>
<tr>
<td>1500</td>
<td>2</td>
<td>0.02</td>
</tr>
<tr>
<td>2000</td>
<td>52</td>
<td>0.52</td>
</tr>
<tr>
<td>3000</td>
<td>52</td>
<td>0.52</td>
</tr>
<tr>
<td>4000</td>
<td>52</td>
<td>0.52</td>
</tr>
</tbody>
</table>

Model Graph:

![Chart showing Time out Vs Throughput]
Experiment 7 – STOP & WAIT WITH BER

Aim:
Provide reliable data transfer between two nodes over an error network using the stop-and-wait protocol

Procedure:
1. Set the error rate to $10^{-2}$ in the NEU.
2. Follow the Stop and Wait Experiment procedure for running the experiment.
3. Set the time out value as 3000 ms in the sender window.

4. From the Statistics window note down the number of successfully transmitted packets and calculate the throughput. (Calculation of throughput is same as explained in the previous expt.)
5. Repeat the Experiment by setting different BER in the NEU.
6. Use the values to plot the graph between BER Vs Throughput

Note: You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template
**Model Tabulation:**

<table>
<thead>
<tr>
<th>BER</th>
<th>Successfully Tx packets</th>
<th>Theoretical Throughput</th>
<th>Practical Throughput</th>
</tr>
</thead>
<tbody>
<tr>
<td>$10^{-6}$</td>
<td>53</td>
<td>0.53</td>
<td>0.53</td>
</tr>
<tr>
<td>$10^{-5}$</td>
<td>52</td>
<td>0.52</td>
<td>0.5232</td>
</tr>
<tr>
<td>$10^{-4}$</td>
<td>9</td>
<td>0.49</td>
<td>0.4675</td>
</tr>
<tr>
<td>$10^{-3}$</td>
<td>40</td>
<td>0.39</td>
<td>0.1787</td>
</tr>
<tr>
<td>$10^{-2}$</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

**Model Graph:**

![BER Vs Throughput Graph](image-url)
Experiment 8 – SLIDING WINDOW GO BACK N

Aim:
Provide reliable data transfer between two nodes over an unreliable network using the sliding window go back N protocol

Procedure:
1. Click on the Sliding Window GBN icon from the desktop on both PCs.
2. Click the Configuration button in the window in both the PC’s.

PC 1 SENDER

PC 2 RECEIVER

Setting the configuration menu:

<table>
<thead>
<tr>
<th></th>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node id</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Protocol</td>
<td>CSMA/CD</td>
<td>CSMA/CD</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>8Kbps (At both the config menu and NEU)</td>
<td>8Kbps (At both the config menu and NEU)</td>
</tr>
<tr>
<td>Duration</td>
<td>100s</td>
<td>100s</td>
</tr>
<tr>
<td>Packet Length</td>
<td>1000 bytes</td>
<td>1000 bytes</td>
</tr>
<tr>
<td>Bit Delay</td>
<td>0(at NEU)</td>
<td>0(at NEU)</td>
</tr>
<tr>
<td>Direction</td>
<td>Sender</td>
<td>Receiver</td>
</tr>
<tr>
<td>No of packets</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>Bit Delay</td>
<td>0(at NEU)</td>
<td>0(at NEU)</td>
</tr>
<tr>
<td>Direction</td>
<td>Sender</td>
<td>Receiver</td>
</tr>
<tr>
<td>No of packets</td>
<td>4</td>
<td>4</td>
</tr>
</tbody>
</table>

Note: The No of Packets parameter defines the window size.

3. Set the Inter Packet Delay to 400msecs
4. Click OK button and Download the driver to the NIU using the BOOT button command. Booting from any one of the applications is enough.
5. Run the experiment by clicking button or by choosing RUN → Start from each application.

6. Set the Timeout Value to 1500 ms

![PC 1 SENDER](image1)

![PC 2 RECEIVER](image2)

7. Note down the no of successfully Transmitted Packets.

8. Repeat the above steps for various time out values and plot the graph between timeout Value & Throughput. Find the optimum timeout value from the plot.

**Note:** You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template

9. Explain why the throughput is less compared to CSMACD protocol.

**Calculation of Practical Throughput:**

\[
X = \frac{\text{(Sum of Successfully Tx packets} \times \text{Packet Length} \times 8)}{\text{(Duration of Experiment} \times \text{Data rate)}}
\]
Model Tabulation:

<table>
<thead>
<tr>
<th>Time out value in ms</th>
<th>Successfully Tx packets</th>
<th>Practical Throughput</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1500</td>
<td>33</td>
<td>0.33</td>
</tr>
<tr>
<td>2000</td>
<td>65</td>
<td>0.65</td>
</tr>
<tr>
<td>3000</td>
<td>66</td>
<td>0.66</td>
</tr>
<tr>
<td>4000</td>
<td>67</td>
<td>0.67</td>
</tr>
</tbody>
</table>

Model Graph:

Time out Vs Throughput

Throughput

Time Out
Experiment 9 – SLIDING WINDOW GO BACK N WITH BER

Aim:
Provide reliable data transfer between two nodes over an error network using the sliding window GBN protocol

Procedure:
1. Set the error rate to $10^{-2}$ in the NEU.
2. Follow the Sliding Window GBN experiment procedure for running the experiment.
3. Set the time out value as 3000 ms in the sender window.
4. From the Statistics window note down the number of successfully transmitted packets and calculate the throughput. (Calculation of throughput is same as explained in the previous expt.)
5. Repeat the Experiment by setting different BER in the NEU.
6. Use the values to plot the graph between BER Vs Throughput

Note: You can also use the template for plotting the graph. Please refer Appendix-1 to plot the graph using the template
Model Tabulation:

<table>
<thead>
<tr>
<th>BER</th>
<th>Successfully Tx packets</th>
<th>Theoretical Throughput</th>
<th>Practical Throughput</th>
</tr>
</thead>
<tbody>
<tr>
<td>$10^{-6}$</td>
<td>53</td>
<td>0.63</td>
<td>0.67</td>
</tr>
<tr>
<td>$10^{-5}$</td>
<td>52</td>
<td>0.55</td>
<td>0.16</td>
</tr>
<tr>
<td>$10^{-4}$</td>
<td>9</td>
<td>0.18</td>
<td>0.01</td>
</tr>
<tr>
<td>$10^{-3}$</td>
<td>40</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>$10^{-2}$</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Model Graph:
Experiment 10 – PACKET TRANSMISSION

1. Click on the Pkt icon from the desktop of both the PC’s.
2. Click the Configuration button in the window in both the PC’s.

PC 1 SENDER

PC 2 RECEIVER

Setting the configuration menu:

<table>
<thead>
<tr>
<th></th>
<th>PC 1</th>
<th>PC 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Node id</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Baud Rate</td>
<td>8Kbps (At both the Config menu and NEU)</td>
<td>8Kbps (At both the config menu and NEU)</td>
</tr>
<tr>
<td>Duration</td>
<td>100s</td>
<td>100s</td>
</tr>
<tr>
<td>Packet Length</td>
<td>100 bytes</td>
<td>100 bytes</td>
</tr>
<tr>
<td>Bit Delay</td>
<td>0(at NEU)</td>
<td>0(at NEU)</td>
</tr>
<tr>
<td>Direction</td>
<td>Sender</td>
<td>Receiver</td>
</tr>
<tr>
<td>Boot File Name</td>
<td>C:\Lantrain\Bin\LANTV13.EXE</td>
<td>C:\Lantrain\Bin\LANTV13.exe</td>
</tr>
</tbody>
</table>

3. Download the driver to the NIU using the BOOT button command for both PCs.
4. Run the Receiver node first & then the transmitter window. Enter the receiver’s node ID in the sender’s dialogue box, once it is prompted.
5. After this the sender will display another **Get String** dialogue box, here you can key in your string using the keyboard & press the ok button.
6. Observe the text in the receiver node. If an empty message is sent, both the sender and receiver should terminate.

Set the BER to $10^{-4}$ and repeat the above-mentioned steps and observe the results.
Experiment 11 – FTP

1. Click on the FTP icon from the desktop on both PCs.
2. Click the Configuration button in the window in both the PC’s.

PC 1 SENDER

PC 2 RECEIVER

<table>
<thead>
<tr>
<th>Setting the configuration menu:</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>PC 1</strong></td>
</tr>
<tr>
<td>Node id</td>
</tr>
<tr>
<td>Baud Rate</td>
</tr>
<tr>
<td>Duration</td>
</tr>
<tr>
<td>Packet</td>
</tr>
<tr>
<td>Bit Delay</td>
</tr>
<tr>
<td>Direction</td>
</tr>
</tbody>
</table>

3. Set the IPD as 40 ms.
4. Download the driver to the NIU using the BOOT button command for both PCs.
5. Run the Receiver node first & then the transmitter window. While you do this, the sender node will display a **GetInt** message box, if you want to transmit a file from Client to server, Enter 1 or else if you want to download a file from Server to client, press 2.

**PC 1 SENDER**

6. Then Specify the Path of the file either to transmit or to download (i.e. c:\test.txt) & specify the timeout value.

**PC 1 SENDER**
7. At the end of transmission, the file will be stored in the server node’s desktop.

PC 1 SENDER

PC 2 RECEIVER
Procedure to plot graph for MAC Layer experiments using MS EXCEL template

Save the readings of the MAC layer experiments by clicking Save button from the Statistics window in all the nodes.

By default the file get saved in the Desktop. (You can also save it in other location). Organise all the files in a common location.

Open MS EXCEL.

Browse open .xls file in c:\Lantrain\Stat.... (Say:\Lantrain\Stat\Aloha\P100\ALOHAP100.xls).

Click Node1 sheet.

Go to Data ⇒ Refresh data.
Browse the respective file to be replaced with existing data for Node1.

Repeat the above step for all the four nodes.

Now click the RESULT USING 4 nodes sheet to view the graph.
**Note:** Save exact seven readings for **MAC** experiments while using this template. Shortage or excess number of readings may produce errors.
Procedure to plot graph for MAC Layer experiments using MS EXCEL template

Save the readings of the LLC layer experiments by clicking Save button from the Statistics window from the sender and receiver nodes.

By default the file get saved in the Desktop. (You can also save it in other location). Organise all the files in a common location.

Open MS EXCEL.
Browse open .xls file in c:\Lantrain\Stat.... (Say:\Lantrain\Stat\Stop and Wait\P1000\Stop and wait P1000.xls).
Click Timeout Vs X sheet.
Scroll up to the sender readings.
Go to Data → Refresh data option.

Browse the respective file to be refreshed for the existing data.

Repeat the same to refresh the existing Receiver data with your data.
9. Follow the same procedure to Plot BER vs X.
Config View displays the configuration dialog box where all the parameter values are displayed.

**Node Id** - Specify that that particular application/experiment window should be as node 0 or 1. This is the one that differentiates the two applications in the same PC.

**Protocol** - Specify the MAC Protocol that NIU has to emulate. By default, it is set to Aloha.

**Baud Rate** - Specify the data rate between 8Kbps and 1Mbps. (Only for CSMA/CD and Ring mode, this needs to be set both in the Application window and the NEU. For Aloha and CSMA, settings in NEU are sufficient.)

**No of Nodes** - Specify the number of nodes in the network that are used to do Token Ring experiment. This field may be used for other purposes while writing codes for suggested experiments in exercise also.

**Duration** - Specify the duration of the experiment in seconds.

**Packet Length** - Specify the length of packets that are used in the experiment. Can be set to a maximum of 1000 bytes.
Inter Packet Delay - Specify the inter packet delay (that is equivalent to the inter packet arrival time) based on the calculation suggested in the experiments. This has to be in milliseconds.

Number of Packets - Specify number of packets in a window for Sliding Window experiment. This field may be used for other purposes while writing codes for suggested experiments in exercise, say for example, to specify number of packets to be transmitted or received in a MAC experiment instead of following time.

My Address - Specify the address of each node (between 1 and 6) in top layers. For example, the server uses this field in FTP to identify the client for sending and receiving files.

Rx Mode - Specify Promiscuous or Non-Promiscuous mode of packet reception. By default all the stand-alone experiments use promiscuous mode of reception (receives all the packet). Altering this field will not have effect in the stand-alone experiments. Refer programmer’s manual for using various types while writing codes for exercises.

I/O Mode - Fixes the types of transmit and receive modes. In majority of the stand-alone experiments, blocking transmit and receive is used and the other types are left for the user to implement wherever necessary as suggested in exercises. Altering this field will not have effect in the stand-alone experiments. Refer programmer’s manual for using various types while writing codes for exercises.

Token Release Mode - Specify the type of token release mode to be followed in token ring. Manual token release is used in token ring experiment. Altering this field will not have effect in this stand-alone experiment. Refer programmer’s manual for using various types while writing codes for exercises.

Direction - Specify which direction to be followed by each node. In MAC experiments, Sender will only transmit data packets and Receiver will only receive. In DLL experiments, Sender will transmit data packets and receive acknowledgement packets while Receiver will receive them and transmit acknowledgement packets. In FTP Sender is the client and Receiver is the server.

Boot File Name - Name and path of the NIU driver file. This is for future use. The default file and location is C:\Lantrain\bin\LantV13.exe. It may be left to this default name.
Developing LAN Trainer Applications

The LAN Trainer API is a Windows DLL (Dynamic Link Library) written in C. Microsoft Visual C++ compiler that comes under Microsoft Visual Studio is used for the Shell and the experiments. Microsoft Visual Studio provides a development environment for Visual C++. This integrated set of tools runs under Windows 95, 98, Windows NT or Windows 2000 or other operating systems as recommended by Microsoft. The Developer Studio user-interface consists of an integrated set of windows, tools, menus, toolbars, directories, and other elements that allow you to create, test, and refine your application in one place.

This Appendix describes the organization of the source code into workspaces and projects and how you can use the LAN Trainer to write network software. You can modify the source code of the experiments supplied with the LAN Trainer or implement different protocols and projects by creating them as new experiments. Finally, if you wish, you can customize the LAN Trainer shell.

Organisation of LAN Trainer Source Code

LAN-T software uses a single workspace for all the experiments and therefore all experiment projects are created under the workspace called Expts.dsw that will be in C:\Lantrain\Src directory.

A workspace is the one that contains one or more projects. A project is the one that generates the executable file (ex: MAC.exe). In LAN-T software, Expts.dsw is the workspace and the experiments are the projects namely, MAC (for ALOHA, CSMA, CSMA/CD), TknBus, TknRing, Pkt, SIWinGBN, StopWait, FTP.

Modifying an Existing Experiment

MAC experiment is taken here as an example to list the steps involved in modifying an existing experiment. Each experiment is a project under the workspace discussed above.

- Open experiment workspace from the following path C:\Lantain\Src\Expts.dsw in VC++
- Make the project that you want to modify, say MAC, active using the option Set Active Project from the Project menu.
- Open MAC.cpp from the Source folder and do the necessary coding.
- Save workspace using Save Workspace menu option under File menu and Build the project (Build is the process of compilation and linking that creates the *.exe file that is ready to run) using the key F7. Once the Build result is successful run the experiment by pressing the keys Ctrl+F5. Please refer Microsoft VC++ User Manual for more options in compiling and linking a project file.
Creating a New Experiment

- Open experiment workspace from the following path `C:\Lantrain\Src\Expts.dsw` in VC++

- Create a new project by clicking New in the File menu.

- Choose a project name (say Test) and choose MFC Appwizard (EXE) as project type. Check the option Add to current workspace and finally click the OK button.

- Select Single document and click Finish button. Now the wizard will create a Project Workspace (Test) with three directories namely Source Files (containing *.cpp files), Header Files (containing *.h files) and Resource Files (containing resource files) under it. This project will now be the active project as far as VC++ workspace is concerned.

- Delete all the files from this project workspace i.e. from Source Files, Header Files and Resource Files directory. [To delete a file from workspace click that file and press Del key.]

- Open Windows Explorer and delete all files from the working directory (`C:\Lantrain\Src\Test\`) including the Res directory except the *.dsp file – in our example it is Test.dsp file.

- Copy the following files from `C:\Lantrain\Src\ShellVxy\` to the current project directory `C:\Lantrain\Src\Test\`

  - Res directory.
  - `stdAfx.cpp` and `stdAfx.h`
  - `resource.h` and `resource.hm`
  - `lanT.rc` and `lanT.aps`
  - A sample `mac.cpp` file
  - Rename this `mac.cpp` file as `Test.cpp`
  - Note: The directory and filename Shellxy represents the LAN-T Shell with Version specified by x and y. For example SHellV13 denotes LAN-T Shell Ver1.3

- Above said files have to be added in the project workspace under the appropriate folder names. To add, click the folder name (say Source Files) and right click the mouse button and select Add files to Folder. This will open up the File Open dialog box through which you can add files that are listed below in their appropriate folders.
Appendix 3

Developing Lan-T applications

- Select Source Files folder and add the following
  
  - lanT.rc
  - stdAfx.cpp
  - Test.cpp file

- Select Header Files folder and add the following
  
  - resource.h
  - resource.hm
  - stdAfx.h

- Select Resource Files folder and add all the files in the Res directory.

- Now save the entire workspace.

  - Under Projects menu select Settings and do the following:

- Select General tab and choose Use MFC in a static library.

- Select Link tab and link the libraries by writing Shellvxy.lib Lanrn.lib in the Object/Library modules field.

- Select C\C++ tab and select the category as Precompiled headers and select the Automatic use of precompiled headers option.

- Click OK button.

  - Under Tools menu select Options and select directories tab.

- Pull down Show directories for and select include files. Write C:\Latrain\Include as the last entry in the Directories field that lists already other required files.

- Pull down Show directories for and select library files. Write C:\Lantrain\lib as the last entry in the Directories field that lists already other required files.

- Save the entire workspace and the project is ready for coding and compilation.

- Choose the Test.cpp file and do the necessary coding and Build it by pressing the key F7 and run it by pressing Ctrl+F5.
Customising the Shell

The user-interface for all LAN Trainer experiments is provided by a collection of functions referred to as the Shell. This method is followed to focus the topic of interest in the algorithm or the method followed in implementing a protocol than on the user-interface part. Even though it is recommended to concentrate on the protocols and its implementation the complete source code for the Shell is given in `C:\Lantrain\Src\ShellVxy` directory for the user to customize according to their requirements. The last two alphabets in the filename represent the version number. For example `ShellV13` file is the Shell file of version number 1.3. If you wish to customize the Shell, follow the steps given below:

- Open experiment workspace from the following path `C:\Lantrain\Src\Expts.dsw` in VC++
- Create a new project by clicking `New` in the `File` menu.
- Choose a project name (say `ShellTest`) and choose `Win32 Static Library` as project type. Check the option `Add to current workspace` and finally click the OK button.
- Click `Finish` button. Now wizard will create a project with two directories namely `Source Files` and `Header Files`. Add a new folder called `Resource Files` by clicking the right button of mouse on the project name (here `ShellTest files`) and selecting `New Folder`. This will open up a dialog box with `Name of the Folder` field and `File extensions` field. In the first field give the name as `Resource Files` and in the second field give `*.*` as file extensions.
- Open windows explorer and copy all the files from `C:\Lantrain\Src\ShellVxy\` directory to the current project directory `C:\Lantrain\Src\ShellTest\`. This current project directory would have been created in the hard disk as soon as the project is added in the workspace as said in the above step.
- Above said files have to be added in the project workspace under the appropriate folder names. To add, click a folder name (say `Source Files`) and right click the mouse button and select `Add files to Folder`. This will open up the File Open dialog box through which you can add files that are listed below in their appropriate folders.
  - Select `Source Files` folder and add the following
    - all cpp files `(*.cpp)`
    - `lanT.rc`
Appendix 3  Developing Lan-T applications

- Select Header Files folder and add the following
  - all header files (*.h)
  - resource.hm

- Select Resource Files folder and add all the files in the Res directory.
  - Under Projects menu select Settings and do the following:

- Select General tab and choose Use MFC in a static library.

- Select C\C++ tab and select the category as Precompiled headers and select the Automatic use of precompiled headers option.

- Click OK button.
  - Under Tools menu select Options and select directories tab.

- Pull down Show directories for and select include files. Write C:\Latrain\Include as the last entry in the Directories field that lists already other required files.

- Pull down Show directories for and select library files. Write C:\Lantrain\lib as the last entry in the Directories field that lists already other required files.

- Save the entire workspace and the project is ready for coding and compilation.
  - Shell has all *.cpp files appropriate for the dialogs used in the user-interface and mainframe.cpp for tool bar and menu. You may modify them or add or remove dialogs as you wish and save them.

- After finishing the coding, Build it by pressing the key F7 and it will create a lib file (here ShellTest.lib) in the debug directory. Copy this lib file from the debug directory to C:\Lantrain\Lib directory and copy Ltulib.h from the shell working directory (here C:\Lantrain\ShellTest\) to C:\Lantrain\Include directory.

**Linking the new Shell library with experiments**
1. 1. Copy the following files from the working directory of the newly created library (here C:\Lantrain\Src\ShellTest\) to the experiment project directory (say C:\Lantrain\Src\MAC\) - the one you wish to use with the new user-interface:
   b. b. stdAfx.cpp and stdAfx.h
   c. c. resource.h and resource.hm
   d. d. lanT.rc and lanT.aps

2) 2) Under Projects menu select Settings and select Link tab and link the library by changing the old library name to new library name alone (say ShellV13.lib to ShellTest.lib) in the Object/Library modules field. Leave the Lantrn.lib as unchanged in that field.

3) 3) Select RebulidAll from the Project menu to compile the experiment. Now the experiment is ready to run with the new user-interface.